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Digital Dictation

INLEIDING

Digital Dictation is een software pakket dat het mogelijk maakt Winamp aan te sturen met
een voetpedaal.

Dit document is een handleiding bij deze software en beschrijft hoe het pakket geinstalleerd
wordt, welke functies aangeboden worden en bevat een uitleg over wat te doen bij
eventuele problemen.

Nieuw in versie 1.1 is "Tempo Control" u vindt hierover meer informatie op pagina 17.
Nieuw in versie 1.2 is Winamp 5.03.

Het Digital Dictation pakket kan uitgebreid worden met diverse opties. Meer informatie
hierover kunt u vinden op http://www.dig-dictation.com
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1 SYSTEEMEISEN

Om de Digital Dictation software te gebruiken adviseren wij minimaal het volgende systeem:

Minimaal een Pentium 11 400 of vergelijkbaar.
Minimaal 64 Mb geheugen (voor Windows XP 128Mb).

Minimaal 10 Mb vrije hardeschijf ruimte.
Minimaal 1 vrije USB poort.

Digital Dictation werkt onder de besturingssystemen Microsoft Windows 2000 en Microsoft
Windows XP.

Oudere versies, zoals Windows 3.1x, Windows 95, Windows 98, Windows ME en Windows
NT worden niet ondersteund.
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2 INSTALLATIE HANDLEIDING

De eerste stap in de installatie van Digital Dictation is het aansluiten van het voetpedaal.
Steek de stekker van het voetpedaal in een vrij USB poort van uw computer. Windows zal
het apparaat automatisch registreren.

Om de installatie te kunnen voltooien moet u ingelogd zijn als Administrator. Mocht dit niet
het geval zijn: Neem dan contact op met uw systeembeheerder.

Wanneer u de CD in uw CDROM of DVDROM speler stopt zal automatisch het volgende
scherm geladen worden. Mocht er niets gebeuren dan kunt u de cdrom openen en op
autorun.exe klikken.

DataVisual

digital-dictation

Install Digital Dictation

"u’ew Manual

Visite Websrte

T —— S M s |

U kunt nu kiezen uit 4 opties, nl:

- Install Digital Dictation
Hiermee start u de installatie.

- View Manual
Hiermee opent u deze handleiding als pdf bestand.

- Visite Website
Opent een browser en laadt de website van Digital Dictation;
www.dig-dictation.com.

- Quit

Sluit het installatie programma van Digital Dictation.

Klik op “Install Digital Dictation” om Digital Dictation op uw computer te installeren.
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U krijgt vervolgens het welkomstscherm van het installatie programma te zien:

Installer Language x|

K I Zancel

Kies de taal waarin u deze installatie voort wil zetten.
Klik op OK om de installatie voort te zetten.

Het volgende scherm is de license agreement:

jis Digital Dictation Installatie: Licentie Dvereenk o Im] e
Chaital Dictation License &greement
=
o]
By continuing thiz installation you agree to this icense agreement. ﬂ
1 LICEMSE GRAMT. Datavisual allows you to uze the digital dictation software

on a zingle computer.

2RESTRICTIONS. The licenzee may not; [irediztribute the product without

written approval of Datavizual; [i] modify or create any denvative works af the
Product or documentation, including translation or lacalization; [ii] decompile,
dizazzemble, reverse engineer, or athenwize attempt to derive the source code

for the Product ; [iv] redistribute, encumber, zell, rent, lease, sublicense, or
othenwize transfer rights to the Product: [+] remove or alker any trademark, logo, ;I

(o PR R TR} [ ) PSP S [yt Py U (R [P S [ | P [P PR Y

¥ Jlk accepteer de overeenkomst
o~

Annuleren | Mullsaft Install Systenm w2, 0bd {  volgende > |::‘

Lees deze tekst aandachtig door. Met de pijltjes aan de rechter kant van het scherm kunt u
door de tekst bladeren.

Vink Ik accepteer de overeenkomst aan als u accoord gaat met de algemene voorwaarden
en klik op Volgende.
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Voordat de installatie start, moet u eerst uw registratie code invoeren:

i'B:'! Digital Dictation Installatie: Enter Your Register Inf —10O0] x|

— Reqgister Information

Yaur Fook Pedals Serialumber

Your Reqgistration code

annuleren | Mullsoft Install Systen w2, Obs < Yorige | EDh;lEndE:"I

Het serial nummer van het voetpedaal kunt u vinden op de onderkant van het voetpedaal of
op het bijgeleverde licentie document.

De registratie code kunt u ook op het licentie document vinden.
Klik op Volgende om door te gaan met de installatie.

Mocht u de verkeerde code hebben ingetypt dan krijgt u de volgende melding te zien;
probeert u het dan opnieuw.

ih:'! Digital Dictation Installz X

Sorry, This Reqgistration Code is Incorrect

Als u de registratie goed heeft ingevuld krijgt u de melding:

jis- Digital Dictation Instal x|

Thank, wou For choosing Digital Dickakion
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Het volgende scherm deelt u mede dat Winamp geinstalleerd gaat worden. Klik op next om
deze installatie te starten.

iic- Digital Dictation I x|

First ‘Winamp will be installed

De Winamp installatie start met opnieuw een License Agreement:

E

=j Winamp Setup: License Agreement El
(Y |m Winamp is a freeware product. Please read the license terms below before
o inztaling.
W AP CLIERT LICEMSE AGREEMEMT -

B CLICKING THE ACCEPTAMCE BUTTOM OR INSTALLING OR USIMG
THE w/INAMP CLIENT SOFTWARE [THE "PRODUCT"]. THE INDIWIDILIAL
OR EMTITY LICEMSING THE PRODUCT [MLICEWSEE"] IS COMSEMTING TO
BE BOUMD BY AMD 15 BECOMING & PARTY TO THIS AGREEMEMT. IF
LICEMSEE DOES NOT AGREE TO ALL OF THE TERMS OF THIS
AGREEMEMT, THE BUTTOM INDICATING MOM-ACCEPTAMCE MUST BE
SELECTED. AMD LICEMSEE MUST HOT INSTALL OR USE THE FRODUCT.

1. LICEMSE GRAMT. Mullzoft, Inc. ["Mullzaft''] grants Licenzee a
noh-excluzive and non-tranzferable license to reproduce and uze for perzonal or LI

Cancel | Hullzaft  nstall System w145 < Back | SN E:-:t>|

Klik op Next >

In het volgende scherm kunt u kiezen wat u geinstalleerd wilt hebben. Wij raden u aan dit
scherm onveranderd te laten.



Digital Dictation

i Winamp Setup i 100} =}

Choosze Components
mm Choose which features of Winamp you want ko install,

This will install \Winamp 5,03, This installer contains the lite install,

Select the tvpe of install: it -

O, select the optional
components yaou wish to
install:

; Winamp (required)

' winamp Agent

-- User Inkerface Extensions

- [#] audio File Support

- [#] visualization

-- Extra sudio OukpukfEffect Support

Space reguired: 1,5ME

Hullsoft Install Swstem -- builk on 3/26/2004 at 113838 &M

% Back I Mext = I Cancel

Klik op Next >
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In het volgende scherm kunt u de installatie directory aangeven. Wij adviseren u deze niet te
veranderen, omdat Digital Dictation dan niet correct zal installeren.

i
Choose Install Location
m Choose the falder in which to install Winamp.

Setup has determined the optimal location to install, IF vou would like to change the directory,
do so now,

Browse, .. |

"Destinatinn Falder

Space required: 1,.5MB
Space available: 7.6GE

rdullsaft Install Systen - bk on 2/ 26/2004 &t 113858 A0

% Back I Mext = I Cancel

Klik op Install

Winamp wordt geinstalleerd. Na de installatie verschijnt het volgende scherm:

fi& Winamp Setup B ] |
Internet Connection Settings
m Configure Winamp's path to the outer world,

Inkernet connection:

Mot connected to the inkernet j

Always connected (LAM, DSL, Cable)
HTT|Connected via dial-up (Modem

Mok connecked ko the inkernet

™ Use prosy only For part 80 URLs

rullsoft Install Systen -- builk on 32612004 gt 113838 &M

< Back I Install I Cancel |

Kies bij “How should Winamp connect to the Internet?”: No internet connection
available.

Klik op Next >

De Winamp installatie is voltooid. U gaat weer terug naar de Digital Dictation installatie.
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U kunt het pad wijzigen waar Digital Dictation geinstalleerd moet worden. Wijzig deze dus
niet.

i'B:'! Digital Dictation Installatie: Installatie Map = = 1O] =]

| Setup zal Digital Dickation in de volgende map installeren. klik op Bladeren
als uin een andere map wilt inskalleren en seleckeer een andere map. Klik
op Installeren om de installatie ke starten.

I Z:'Program Fileshwinamp!Plugins Bladeren. .. |

"Installatie Map

Vereiske ruimte: 64.0KB
Beschikbare ruimbe; 8,756

Annuleren | Mullsaft Install System w2, ohd < Worige |

Klik op Installeren.
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3 UNINSTALL DIGITAL DICTATION

Om de software te deinstalleren gaat u naar Start -> Programma’s -> Winamp -> Uninstall
Digital Dictation.

¥ Digital Dictation Uninstall: Confirmation i x|

Thiz will uninztall Digital Dictation

IIninstalling from: IE:'\P‘ngram Filezhwinamp.Plugin:

Cancel | [ ullzaft netall Spstem W1 598

Klik op Uninstall.

¥ Digital Dictation Uninstall: Completed i x|

m:‘-. Completed

Show detailz |

[Eanze | [ ullzaft netall Spstem W1 598

Klik op Close om de deinstallatie te beéindigen. Digital Dictation is van uw systeem
verwijderd. De volgende stap is om Winamp te deinstalleren.
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Om Winamp te deinstalleren gaat u naar Start -> Programma’s -> Winamp -> Uninstall

& Winamp Uninstall: Confirmation x|

m-:‘h Thiz will uninstall “Winamp. Continue?

IIninstalling from: IE:'\P‘ngram Filez"wfinamp

Cancel | Hullzaft ] netall Spstem w45 < Back : ety

Klik op Next >.

Wanneer Winamp vraagt om geinstalleerde plugins te deinstalleren klikt u op ja.

x

L B Files in Ci\Program Files\\Winamp were not removed,
“‘:f} Remove all files?

(IF wou have skins or plug-ins that wou wish to save, seleck MOY)

De deinstallatie is voltooid:

\;\[‘) Uninstall complete

Klik op ok. En sluit het deinstalltie programma door op close te klikken.
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4 DIGITAL DICTATION HANDLEIDING

Start het programma door op Start -> Programma’s -=> Winamp -> Winamp te klikken.

Het programma start als volgt op:

U kunt eventuele hulp schermen zoals hieronder beschreven afsluiten. Deze zullen de
volgende keer als u het programma start niet weer getoond worden.

Minibrowser:
WINAMP BROWSER

Winamp

MP3 Internet Radio

wour Winamp a new look

rogram Filesffinampiwinampmb.t

Winamp Playlist

WINAMP PLAYLIST

I — +20dh — I =

—H— +0dh H

- I — -@0dh — I

FREAHF B0 70 310 600 K

(RS (VST (I (R cenens—— EH

U kunt op de eject knop klikken om het bestand te openen dat u wilt uitwerken:

14
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WiNAMP

1 I-:I:-|::= -_I kHz

R, (WS .- |

U krijgt een standaard Windows Open File menu te zien. Ga naar de locatie van uw bestand

en klik op Openen.

21
Zoeken in; I@ Bureaublad j rj( ER-

@Mijn documenten
f} Ceze computer
‘-ﬂMijn netwerklocaties

Bureaublad

in

documenten

Bestandznaam: | j Openen I
Bestandstyper: |.-’-‘n.llsup|:|artedt_l,lpes j Annuleren |

7
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U bent nu klaar om het voetpedaal te gebruiken.

Het voetpedaal biedt de volgende functies:
- Play / Stop
Terug spoelen
Vooruit spoelen
Volume regeling

4.1 Functies van het middelste pedaal
Het middelste pedaal start het afspelen van het audio bestand:

Houdt tijdens het afspelen het voetpedaal ingedrukt. Indien u het voetpedaal los laat stopt
het afspelen, zodat u tijd heeft om te dicteren. Wanneer u het voetpedaal weer indrukt
spoelt de software het audiobestand 1 seconde terug en gaat verder met afspelen.

4.2 Functies van het linker pedaal
Met het linker pedaal kunt u terug spoelen of het volume zachter zetten:

U kunt 1 keer op het linker pedaal klikken om 5 seconden terug te spoelen of het pedaal
ingedrukt houden, om sneller terug te spoelen.

Houdt de CTRL toets en het linker voetpedaal ingedrukt om het volume te verlagen.

16
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4.3 Functies van het rechter pedaal
Met het rechter pedaal kunt u vooruit spoelen of het volume harder zetten:

U kunt 1 keer op het rechter pedaal klikken om 5 seconden vooruit te spoelen of het pedaal
ingedrukt houden, om sneller vooruit te spoelen.

Houdt de CTRL toets en het rechter voetpedaal ingedrukt om het volume te verhogen.

17
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5 WINAMP FUNCTIES

Naast Digital Dictation functies biedt Winamp veel mogelijkheden. U kunt vrijuit gebruik
maken van de standaard mogelijkheden:

| Start afspelen
Stop afspelen
IE Vorige track
Il Volgende track
Ir  Pauzeer het afspelen
Met de slider kunt u snel door een audiobestand scrollen.

Verander het volume.

Naast de standaard functies biedt Winamp ander functies die gebruikt kunnen worden door
het installeren van andere plugins. Wij adviseren u hier geen gebruik van te maken.

Tips
1. Als u wilt dat Winamp altijd zichtbaar is (ook als u bijvoorbeeld in Microsoft Word

werkt) kunt u de always on top functie inschakelen: Klik met de recht muisknop op

het Winamp icoontje E&. Kies nu Options -> Always On Top. Of druk op
Control-A.

2. U kunt Winamp kleiner weergeven:
Klik op shade (rechtsboven); IS, Dit geeft het volgende resultaat:

S HENEH s la@ X
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6 DIGITAL DICTATION TEMPO CONTROL

Vanaf versie 1.1 bevat Digital Dictation Tempo Control Tempo Control maakt het mogelijk de
snelheid van het gesproken woord te vertragen of te versnellen, zodat onduidelijke passages
beter verstaanbaar worden.

Tempo Control kan alleen toegepast worden op MP3 opnames.

Digital Dictation

Tempo:

Ritch

Tempo Control wordt geleverd als uitbreiding en is standaard uitgeschakeld. Wilt u het

Speed

e

| Digital Dickation TPS Control Eeset

inschakelen, volg dan de volgende stappen:

Klik met de recht muisknop op het Winamp icoontje .

Kies Options -> Preferences:

Winamp Preferences

- Setup

- File pes
- Agant

- Optians

- Digplay
- Wiglalization
- Shuffle

- Plug-itg

- Input
- Cukput

- Vizualization
o [1SF/Effect
- General Purposze

- Sking
- Bookmark s

Cloze

—DSP/Effect plug-in

Diigital Dictation TPS Contral +1.0

dzp_DigitalDictation,

Configure |

IDigitaI Dvictation TPS Cantral 1.0

-

et pludg-ins

Kies onder Plug-ins: DSP/Effect en klik Digital Dictation TPS Control v1.0 aan.

Het Digital Dictation Tempo Control venster zal verschijnen.

Digital Dictation

Tempo:

Ritch

Speed

e

| Digital Dickation TPS Control Eeset

Tempo en Speed = tempo versnellen of vertragen terwijl de toonhoogte gelijk blijft.
Pitch = tempo versnellen of vertragen en de toonhoogte wordt ook hoger of lager.
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7/ PROBLEEM OPLOSSINGEN

Mocht u een probleem tegen komen of een foutmelding tegenkomen, controleer dan eerst
de volgende lijst:

- Gebruikt u een besturing systeem met ondersteuning voor USB? Digital Dictation
biedt alleen support voor Microsoft Windows 2000 en Microsoft Windows XP.

- Is het voetpedaal correct aangesloten? Controleer de USB stekker.

- Heeft u de installatie handleiding correct gevolgd en bijvoorbeeld geen andere
directory voor de Winamp installatie gekozen?

Mocht uw probleem niet verholpen zijn, kijk dan op www.dig-dictation.com voor
foutoplossingen en/ of uitleg bij foutcodes.

Mocht u contact met ons op willen nemen, houdt dan de volgende gegevens bij de hand:
- Het serienummer van uw voetpedaal
- Het versie nummer van de Digital Dictation software

Het serienummer van uw voetpedaal kunt u vinden op een sticker aan de onderzijde van het
apparaat.

Kijkt u voor het versienummer in Winamp: Klik met de rechter muisknop op n en kies
Options -> Preferences... -> Plug-ins -> General Purpose:

Winamp Preferences El

- Getup — General purpoze plug-inz [loaded at startup]

- File pes Diigital Dictation +1.1

- hgent

- Optians

- Digplay

- Vizualization

- Shuffle

- Plug-ing

- Input

- Cukput

- Vizualization

- DSP/Effect
B General Purpose

- Sking

- Bookmarks

I Configure [Irinztall Get plug-ing

| Cloze

Het getal naast Digital Dictation (aan de rechter kant van het scherm) is het versie nummer.
In dit geval is het versienummer 1.1.
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